Quartus Il Introduction Using Schematic Design

This tutorial presents an introduction to the Qua@uﬁ CAD system. It gives a general overview of a typi-
cal CAD flow for designing circuits that are implemented byngsFPGA devices, and shows how this flow is
realized in the Quartus Il software. The design procesduistibited by giving step-by-step instructions for using
the Quartus Il software to implement a very simple circuiaimAltera FPGA device.

The Quartus Il system includes full support for all of the plap methods of entering a description of the
desired circuit into a CAD system. This tutorial makes uséhefschematic design entry method, in which the
user draws a graphical diagram of the circuit. Two otherivessof this tutorial are also available, which use the
Verilog and VHDL hardware description languages, respelsti

The last step in the design process involves configuring &ségded circuit in an actual FPGA device. To
show how this is done, it is assumed that the user has accissAdtera DE1 Development and Education board
connected to a computer that has Quartus Il software iegtalA reader who does not have access to the DE1
board will still find the tutorial useful to learn how the FP@Rogramming and configuration task is performed.

The screen captures in the tutorial were obtained using thetQs Il version 9.0; if other versions of the
software are used, some of the images may be slightly diftere
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Computer Aided Design (CAD) software makes it easy to imgleta desired logic circuit by using a pro-
grammable logic device, such as a field-programmable gety @FPGA) chip. A typical FPGA CAD flow is
illustrated in Figure 1.
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Figure 1. Typical CAD flow.

The CAD flow involves the following steps:

e Design Entry — the desired circuit is specified either by means of a schierdagram, or by using a
hardware description language, such as Verilog or VHDL

e Synthesis-the entered design is synthesized into a circuit that stsef the logic elements (LES) provided
in the FPGA chip

e Functional Simulation — the synthesized circuit is tested to verify its functiot@irectness; this simulation
does not take into account any timing issues



e Fitting — the CAD Fitter tool determines the placement of the LEs @effim the netlist into the LEs in
an actual FPGA chip; it also chooses routing wires in the thimake the required connections between
specific LEs

e Timing Analysis — propagation delays along the various paths in the fittemlitiare analyzed to provide
an indication of the expected performance of the circuit

e Timing Simulation — the fitted circuit is tested to verify both its functionakm@xtness and timing

e Programming and Configuration — the designed circuit is implemented in a physical FPGA tlyijpro-
gramming the configuration switches that configure the LEsemtablish the required wiring connections

This tutorial introduces the basic features of the Quartseftware. It shows how the software can be used to
design and implement a circuit specified by means of a schemiagram. It makes use of the graphical user
interface to invoke the Quartus Il commands. Doing thisriatpthe reader will learn about:

e Creating a project

Entering a schematic diagram

Synthesizing a circuit from the schematic diagram

Fitting a synthesized circuit into an Altera FPGA

Assigning the circuit inputs and outputs to specific pinstenEPGA

Simulating the designed circuit

e Programming and configuring the FPGA chip on Altera’s DE1lrbdoa

1 Getting Started

Each logic circuit, or subcircuit, being designed with Quarl software is called pgroject The software works
on one project at a time and keeps all information for thajgmtan a single directory (folder) in the file system.
To begin a new logic circuit design, the first step is to creatirectory to hold its files. To hold the design files
for this tutorial, we will use a directorintrotutorial. The running example for this tutorial is a simple circuit fo
two-way light control.

Start the Quartus Il software. You should see a display ambd the one in Figure 2. This display consists
of several windows that provide access to all the featuréduzrtus Il software, which the user selects with the
computer mouse. Most of the commands provided by Quartudtivare can be accessed by using a set of menus
that are located below the title bar. For example, in Figuolicking the left mouse button on the menu named
File opens the menu shown in Figure 3. Clicking the left mouseobutin the entryExit exits from Quartus Il
software. In general, whenever the mouse is used to seledthing, thdeft button is used. Hence we will not
normally specify which button to press. In the few cases whismecessary to use thmigght mouse button, it will
be specified explicitly.
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Figure 2. The main Quartus Il display.
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For some commands it is hecessary to access two or more nreseglence. We use the conventidenul
> Menu2 > Item to indicate that to select the desired command the user dliost click the left mouse button
on Menul, then within this menu click oMenu2, and then withirMenu2 click on Iltem. For exampleFile >
Exit uses the mouse to exit from the system. Many commands candieeih by clicking on an icon displayed in
one of the toolbars. To see the command associated with anposition the mouse over the icon and a tooltip
will appear that displays the command name.

1.1 Quartus Il Online Help

Quartus |l software provides comprehensive online docuatiam that answers many of the questions that may
arise when using the software. The documentation is acddss® theHelp menu. To get some idea of the
extent of documentation provided, it is worthwhile for tieader to browse through tlelp menu. For instance,
selectingHelp > How to Use Help gives an indication of what type of help is provided.

The user can quickly search through the Help topics by setgktelp > Search, which opens a dialog box
into which keywords can be entered. Another method, corstersitive help, is provided for quickly finding
documentation for specific topics. While using most appiices, pressing th&1 function key on the keyboard
opens a Help display that shows the commands availabledaghlication.

2 Starting a New Project

To start working on a new design we first have to define a design project Quartus Il software makes the
designer’s task easy by providing support in the form wfizard Create a new project as follows:

1. SelecFile > New Project Wizard to reach the window in Figure 4, which asks for the name arettiry
of the project.

New Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5]

‘what iz the working directory for this project?

|D:.-"intr0tut0rial
‘what iz the name of this project?
[ight

‘what iz the name of the top-level design entity for this project? Thiz name iz caze sensitive and must
exactly match the entity name in the design file.

light [

Usze Existing Project Settings ...

| Mest > | Finizh | Cancel

Figure 4. Creation of a new project.



2. Set the working directory to biatrotutorial; of course, you can use some other directory name of your
choice if you prefer. The project must have a name, whichusilisthe same as the top-level design entity
that will be included in the project. Chookght as the name for both the project and the top-level entity, as
shown in Figure 4. Presdext. Since we have not yet created the directiotyotutorial, Quartus Il software
displays the pop-up box in Figure 5 asking if it should crehtedesired directory. Clickes, which leads
to the window in Figure 6.

1 E Directory "Dt fintrotutorial” does not exist, Do you wank to create it?
L

es Mo |

Figure 5. Quartus Il software can create a new directorytferroject.
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Figure 6. The wizard can include user-specified design files.

3. The wizard makes it easy to specify which existing fileali§) should be included in the project. Assuming
that we do not have any existing files, clidlext, which leads to the window in Figure 7.



New Project Wizard: Family & Device Settings [page 3 of 5] @
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Figure 7. Choose the device family and a specific device.

4. We have to specify the type of device in which the desigiredit will be implemented. Choose Cycloh¥
Il as the target device family. We can let Quartus Il softweetect a specific device in the family, or we can
choose the device explicitly. We will take the latter apmtoaFrom the list of available devices, choose the
device called EP2C20F484C7 which is the FPGA used on At&&’1 board. Predsext, which opens the
window in Figure 8.



New Project Wizard: EDA Tool Settings [page 4 of 5]

Specify the other EDA tools - in addition to the Quartus || software - used with the project.
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Figure 8. Other EDA tools can be specified.

5. The user can specify any third-party tools that shoulddeelu A commonly used term for CAD software
for electronic circuits i€£DA tools where the acronym stands for Electronic Design Automafidms term
is used in Quartus Il messages that refer to third-partystashich are the tools developed and marketed
by companies other than Altera. Since we will rely solely ara@us Il tools, we will not choose any other
tools. Presdext.

6. A summary of the chosen settings appears in the screemshdvigure 9. PresBinish, which returns to
the main Quartus Il window, but witlight specified as the new project, in the display title bar, acateid
in Figure 10.



New Project Wizard: Summary [page 5 of 5]

‘When you click Finish, the project will be created with the following settings:

Project directory:

d:/introtutorial?
Project hame: light
Top-level design entity: light
Number of files added: 0

Number of user libraries added: 0
Device assignments:

Family name: Cyclone Il

Device: EP2C20F484C7
EDA tools:

Design entry/synthesis: <None>

Simulation: <None>

Timing analysis: <None>

Operating conditions:
Core voltage: 1.2
Junction temperature range:  0-85 °C

< Back I Next >

Cancel |

Figure 9. Summary of the project settings.
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Figure 10. The Quartus Il display for the created project.



3 Design Entry Using the Graphic Editor

As a design example, we will use the two-way light controdliecuit shown in Figure 11. The circuit can be used

to control a single light from either of the two switches,andz,, where a closed switch corresponds to the logic
value 1. The truth table for the circuit is also given in theufig Note that this is just the Exclusive-OR function

of the inputsz, andz,, but we will implement it using the gates shown.
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Figure 11. The light controller circuit.

The Quartus Il Graphic Editor can be used to specify a ciricuihe form of a block diagram. SeleEile
> New to get the window in Figure 12, choo&ock Diagram/Schematic File, and clickOK. This opens the
Graphic Editor window. The first step is to specify a namelfierfile that will be created. Seleeile > Save As to
open the pop-up box depicted in Figure 13. In the box lab8kagk as type chooseBlock Diagram/Schematic
File (*.bdf). In the box labeledrile name typelight, to match the name given in Figure 4, which was specified
when the project was created. Put a checkmark in theAslkfile to current project. Click Save, which puts
the file into the directoryntrotutorial and leads to the Graphic Editor window displayed in Figure 14

SOPC Builder System ~
=I- Deszign Files
AHDL File
Block Diagram/S chematic File
EDIF File
State Machine File
Systemerlog HOL File
Tel Script File
Werilog HOL File
WHOL File
=I- Memary Files
Hexadecimal [Intel-Format] File
Memory Initislization File
=I- Yerification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalT ap | Logic Analyzer File
Wector Waveform File
—|- Other Files
AHDL Include File
Block Symbal File
Chain Description File
Synopsys Design Constraints File
Text File

v

Cancel

Figure 12. Choose to prepare a block diagram.
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Figure 13. Name the file.

i light. bdf.

Figure 14. Graphic Editor window.

3.1 Importing Logic-Gate Symbols

The Graphic Editor provides a number of libraries which i circuit elements that can be imported into a
schematic. Double-click on the blank space in the GraphitEdindow, or click on theL* icon in the toolbar
that looks like an AND gate. A pop-up box in Figure 15 will appeExpand the hierarchy in the Libraries box as
shown in the figure. First expariithraries, then expand the librargrimitives followed by expanding the library
logic which comprises the logic gates. Selantd2 which is a two-input AND gate, and clicdRK. Now, the AND
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gate symbol will appear in the Graphic Editor window. Usihg tnouse, move the symbol to a desirable location
and click to place it there. Import the second AND gate, whiah be done simply by positioning the mouse
pointer over the existing AND-gate symbol, right-clickjrand dragging to make a copy of the symbol. A symbol
in the Graphic Editor window can be moved by clicking on it alidgging it to a new location with the mouse
button pressed. Next, selamt2 from the library and import the OR gate into the diagram. Tsshectnot and
import two instances of the NOT gate. Rotate the NOT gat@spnbper position by using the “Rotate left 90"

icondZ. Arrange the gates as shown in Figure 16.

Libraries:

[S] @ d:/altera/90/quartus/libraries A
#E megafunctions
#C others
S primitives

Name:
]and2 J

I” Repeat-insert mode
-
-

Megawizard Plug-In Manager... |

oK Cancel |

Figure 15. Choose a symbol from the library.

i light. bdf*

Figure 16. Import the gate symbols into the Graphic Editardeiv.
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3.2 Importing Input and Output Symbols

Having entered the logic-gate symbols, it is now necesseenter the symbols that represent the input and output
ports of the circuit. Use the same procedure as for impotttieggates, but choose the port symbols from the
library primitives/pin Import two instances of the input port and one instance efaltput port, to obtain the
image in Figure 17.

Figure 17. Import the input and output pins.

Assign names to the input and output symbols as follows. Maike nothing is selected by clicking on an
empty spot in the Graphic Editor window. Point to the wpid_nameon the top input symbol and double-click
the mouse. The dialog box in Figure 18 will appear. Type tmerngimex1, and clickOK. Similarly, assign the
namez?2 to the other input ang to the output. Alternatively, it is possible to change theneaof an element by
selecting it first, and then double-clicking on the name apihg a new one directly.

Pin Properties Pz|

General l Farmat ]

To create multiple pins, enter a name in AHDL bus notation [for example,
"namel3..0]"]. or enter a comma-separated list of names.

Fin name(z]: |x1

Drefault value: |VEE j

(] 8 | Cancel

Figure 18. Naming of a pin.
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3.3 Connecting Nodes with Wires

The symbols in the diagram have to be connected by drawieg [wires). Click on the ico ! in the toolbar to
activate the Orthogonal Node Tool. Position the mouse pointer the right edge of thel input pin. Click and
hold the mouse button and drag the mouse to the right untdrtien line reaches the pinstub on the top input of
the AND gate. Release the mouse button, which leaves thedineecting the two pinstubs. Next, draw a wire
from the input pinstub of the leftmost NOT gate to touch theevthat was drawn above it. Note that a dot will
appear indicating a connection between the two wires.

Use the same procedure to draw the remaining wires in theititta mistake is made, a wire can be selected
by clicking on it, and removed by pressing the Delete key enkityboard. Upon completing the diagram, click
on the iconk, to activate the Selection Tool. Now, changes in the appearaf the diagram can be made by
selecting a particular symbol or wire and either moving iatdifferent location or deleting it. The final diagram
is shown in Figure 19; save it.

i light. bdf*

Figure 19. The completed schematic diagram.

4 Compiling the Designed Circuit

The entered schematic diagram filight.bdf, is processed by several Quartus Il tools that analyze thesfjin-
thesize the circuit, and generate an implementation ofritHe target chip. These tools are controlled by the
application program called tHeompiler.

Run the Compiler by selectingrocessing > Start Compilation, or by clicking on the toolbar ico ® that
looks like a purple triangle. As the compilation moves tlglowarious stages, its progress is reported in a window
on the left side of the Quartus Il display. Successful (orugnessful) compilation is indicated in a pop-up box.
Acknowledge it by clickingOK, which leads to the Quartus Il display in Figure 20. In the sage window, at the
bottom of the figure, various messages are displayed. Inafaseors, there will be appropriate messages given.

When the compilation is finished, a compilation report is pit. A window showing this report is opened
automatically, as seen in Figure 20. The window can be résip@ximized, or closed in the normal way, and it

can be opened at any time either by selecingcessing > Compilation Report or by clicking on the icor .

The report includes a number of sections listed on the Id# sif its window. Figure 20 displays the Compiler
Flow Summary section, which indicates that only one log&rednt and three pins are needed to implement this
tiny circuit on the selected FPGA chip.
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Figure 20. Display after a successful compilation.
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4.1 Errors

Quartus Il software displays messages produced during itatiop in the Messages window. If the block diagram
design file is correct, one of the messages will state thatdhwilation was successful and that there are no errors.

If the Compiler does not report zero errors, then there igadtlone mistake in the schematic entry. In this
case a message corresponding to each error found will biagkspin the Messages window. Double-clicking
on an error message will highlight the offending part of tireuit in the Graphic Editor window. Similarly, the
Compiler may display some warning messages. Their detaildoe explored in the same way as in the case of
error messages. The user can obtain more information alspédific error or warning message by selecting the
message and pressing thg function key.

To see the effect of an error, open the fight.bdf. Remove the wire connecting the output of the top AND

gate to the OR gate. To do this, click on tieicon, click the mouse on the wire to be removed (to selecit) a
press Delete. Compile the erroneous design by clicking @ ®ticon. A pop-up box will ask if the changes made
to thelight.bdffile should be saved; clicKes. After trying to compile the circuit, Quartus Il softwarelidisplay

a pop-up box indicating that the compilation was not sudoés&cknowledge it by clickingOK. The compilation
report summary, given in Figure 21, now confirms the faileslite Expand thé\nalysis & Synthesis part of the
report and then seletessages to have the messages displayed as shown in Figure 22. Dolitiesn the first
error message, which states that one of the nodes is missimgree. Quartus Il software responds by displaying
thelight.bdfschematic and highlighting the OR gate which is affectecheyetrror, as shown in Figure 23. Correct
the error and recompile the design.

%> Compilation Report - Flow Summary

R Ll Flow Summary

& B Legal Notice
&S Flow Summary :
ZHE Flow Settings Flow Status Flow Failed - Wed Apr 29 15:07:07 2009
SHER Flow Non-Default Quartus |l Version 9.0 Build 132 02/25/2003 SJ Full Version
&HER Flow Elapsed Tim Revision Name light
EHEA Flow 05 Summary Top-level Entity Name light
=] B Flow Log Family Cyclone |1
+ & Analysis & Synthe Device EP2C20F484C7
Timing Models Final
et timing requirements NZ&
Total logic elements N/& until Partition Merge
Total combinational functions N/A until Partition Merge
Dedicated logic registers N/4 until Partition Merge
Total registers N/& until Partition Merge
Total pins NZ4 until Partition Merge
Total virtual pins NZ4 until Partition Merge
Total memory bits N/& until Partition Merge
Embedded Multiplier 3-bit elements ~ N/& until Partition Merge
Total PLLs NZA until Partition Merge
< >

Figure 21. Compilation report for the failed design.
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‘8 Compilation Report - Analysis & Synthesis Messages
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%é E:z: zztntgg:mt T [ Info: Funning Quartus II Analysis & Synthesis
H i L) Info: Command: quartus map -—-read settings_files=on --write settings files=off light -c light
&HER Fiow Elapsed Time L) Info: Found 1 design units, including 1 entities, in source file light.bdf
é@ Flow L?g 5 Info: Elaborating entity "light” for the top lewel hierarchy
-—--@jnnalysls&synthesls Q! Error: Port "IN1" of type ORZ of instance "instl™ is missing source signal

éEﬁ Sum.mary' " Error: Can't elaborate top-level user hierarchy

£ ét‘ 3ettings (%] Error: Quartus IT Analysis & Synthesis was unsuccegsful. 2 errors, 0 varnings

- & L) Messages

Processing [B]A Estra Info }\ Info (5] }\ Wam\ng__)\_ Critical W atming )\ Enmor (3] }\ F\a_g_f

¢ > Message: 0of 15 Jiﬂ _J Cocate

Figure 22. Error messages.

Figure 23. Identifying the location of the error.

5 Pin Assignment

During the compilation above, the Quartus Il Compiler waefto choose any pins on the selected FPGA to serve
as inputs and outputs. However, the DE1 board has hardwinelections between the FPGA pins and the other
components on the board. We will use two toggle switchegléakt 1V, and S, to provide the external inputs,

x1 andzo, to our example circuit. These switches are connected tBRI&A pins L22 and L21, respectively. We
will connect the outpuyf to the green light-emitting diode labeléd” DG, which is hardwired to the FPGA pin
u22.

17



€ Quartus Il - D:/introtutorial/light - light - [Assignment Editor]
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Figure 24. The Assignment Editor window.

Pin assignments are made by using the Assignment EditoectS&dsignments > Assignment Editor to
reach the window in Figure 24. Und@&ategory selectPin. Double-click on the entry<<new>> which is
highlighted in blue in the column labeled To. The drop-dowenmnin Figure 25 will appear. Click onl as the
first pin to be assigned; this will entei in the displayed table. Follow this by double-clicking oe thox to the
right of this newx1 entry, in the column labeled Location. Now, the drop-dowmmin Figure 26 appears. Scroll
down and seled®IN_L22. Instead of scrolling down the menu to find the desired pim, gan just type the name
of the pin (L22) in the Location box. Use the same procedui@stign inputc2 to pin L21 and outpuyf to pin
U22, which results in the image in Figure 27. To save the assémts made, choo$éle > Save. You can also
simply close the Assignment Editor window, in which case p-pp box will ask if you want to save the changes
to assignments; clickes. Recompile the circuit, so that it will be compiled with therect pin assignments.

Figure 25. The drop-down menu displays the input and outpotas.

Location IIIO Bank |l/0 Standard General Function lSpecid Fur
~ [3.3vLvmmL [
I
[P 315 1/OBarkS  Rowljo -~
PIN_117 I/OBank S Row IfO L¥DS72n
PIN_J18 1/0 Bank 5 Row IfO LYDS73p
PIN_J19 I/OBank 5 Row IfO LYDS73n
PIN_120 IO Bank 5 Row IjO LYDS74n
PIN_J21 IO Bank 5 Row IfO L¥YDS75n
PIN_J22 1/0Bank S Row IfO LYDS75p
PIN_K20 1/0Bank S Row IfO VREFBSN1
PIN_K21 1f0Bank 5 Row IfO LYDS76n
PIN_K22 1f0Bank S Row IfO LYDS76p
PIN_L1 IfO Bank 2 Dedicated Clock. CLKO, LYDSCLKOp, Input
PIN_L2 1O Bank 2 Dedicated Clock CLK1, LYDSCLKON, Input
PIN_L8 I/O Bank 2 Row IfO
PIN_L18 1/0 Bank 5 Row IfO LYDS77p, DPCLK7/DQSORJCQIR
PIN_L19 IfOBank 5 Row IjO LYDS77n
PIN_L21 IfO Bank 5 Dedicated Clock. CLKS, LVDSCLK2n, Input
PIN_L22 IjOBank S Dedicated Clock CLK4, LYDSCLK2p, Input
PIN_M1 IjO Bank 1 Dedicated Clock CLK2, LYDSCLK1p, Input
PIN_M2 I1/O Bank 1 Dedicated Clock. CLK3, LYDSCLK1n, Input
PIN_MS 1JOBank1  RowIjO LYDS15p, DPCLK1/DQSILICQIL# v

Figure 26. The available pins.
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€ Quartus Il - D:/introtutorial/light - light - [Assignment Editor]

File Edit View Tools Window

= & category: [ P ~| @ al| & Timing| ® Logic options
) 4 e X V| [znew>> ]
ITo Location IjO Bank IfO Standard General Function Special Function |Reserved

1 B> x1 PIN_L22 S 3.3-¥ LVTTL Ded ock

= g 2 PIN_L21 S 3.3V LVTTL
nﬂ 3 ko |PIN_U22 2 3.3 LVTTL

T 4 <<new>>

=

o 3
kg

2.4

«L» < >

For Help, press F1 NUM

Figure 27. The complete assignment.

The DE1 board has fixed pin assignments. Having finished osigrdethe user will want to use the same
pin assignment for subsequent designs. Going through teedure described above becomes tedious if there
are many pins used in the design. A useful Quartus Il featilme/sithe user to both export and import the pin
assignments from a special file format, rather than credtiegn manually using the Assignment Editor. A simple
file format that can be used for this purpose isethenma separated value (CSi@ymat, which is a common text
file format that contains comma-delimited values. This filmfat is often used in conjunction with the Microsoft
Excel spreadsheet program, but the file can also be createaruyusing any plain ASCII text editor. The format
for the file for our simple project is

To, Location
x1, PIN_L22
x2, PIN_L21
f, PIN_U22

By adding lines to the file, any number of pin assignments eacrbated. Sucbsvfiles can be imported into any
design project.

If you created a pin assignment for a particular project, ga export it for use in a different project. To see
how this is done, open again the Assignment Editor to reaelwthdow in Figure 27. Now, sele€ile > Export
which leads to the window in Figure 28. Here, the fight.csvis available for export. Click ofExport. If you
now look in the directoryntrotutorial, you will see that the fildight.csvhas been created.
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Save in: l_) introtutorial LI ﬁl‘ '
LY db
4 ‘/, “j
My Recent
Documents
ey
L&
Desktop

My Documents

@

My Computer
)
My Network  File name: light j Export
Places
Save as type: [Comma Separated Value File [*.csv) L] Cancel

Figure 28. Exporting the pin assignment.

You can import a pin assignment by choosisgsignments > Import Assignments. This opens the dia-
logue in Figure 29 to select the file to import. Type the namtheffile, including thecsvextension and the full
path to the directory that holds the file, in the File Name bad presOK. Of course, you can also browse to find
the desired file.

Import Assignments

Specify the source and categories of assignments to import.

FEile name: |
[v Copy existing assignments into light.gsf.bak before importing

,—I Cancel l

Figure 29. Importing the pin assignment.

For convenience when using large designs, all relevantgsiyaments for the DE1 board are given in the file
calledDE1_pin_assignments.c8vthe directoryDE1_tutorials design_fileswhich is included on the CD-ROM
that accompanies the DE1 board and can also be found on AIREA web pages. This file uses the names found
in theDE1 User Manual If we wanted to make the pin assignments for our exampleitiby importing this file,
then we would have to use the same names in our Block Diagdmafsatic design file; namelgW[0], SW[1]
andLEDGI0] for x1, x2 andf, respectively. Since these signals are specified ilDtag_pin_assignments.cfie
as elements of vecto®WandLEDG, we must refer to them in the same way in our design file. Fomga, in
theDE1_pin_assignments.céie the 10 toggle switches are call&iV[9]to SWIO0]. In a design file they can also
be referred to as a vect&WwW[9..0]

6 Simulating the Designed Circuit

Before implementing the designed circuit in the FPGA chiptlom DE1 board, it is prudent to simulate it to
ascertain its correctness. Quartus Il software includésalation tool that can be used to simulate the behavior
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of a designed circuit. Before the circuit can be simulatet necessary to create the desired waveforms, called
test vectorsto represent the input signals. It is also necessary tafgpeigich outputs, as well as possible internal
points in the circuit, the designer wishes to observe. Thwikitor applies the test vectors to a model of the

implemented circuit and determines the expected respdisavill use the Quartus Il Waveform Editor to draw
the test vectors, as follows:

1. Open the Waveform Editor window by selectifide > New, which gives the window shown in Figure 30.
ChooseVector Waveform File and clickOK.

SOPC Builder System -~
= Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
State Machine File
SystemVerilog HOL File
Tel Script File
Verilog HDL File
VHDL File
= Memory Files
Hexadecimal (Intel-Format) File
Memory Initialization File
-I Verification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalT ap Il Logic Analyzer File
=1 Other Files
AHDL Include File
Block Symbol File
Chain Description File
Synopsys Design Constraints File
Text File

v

Cancel

Figure 30. Need to prepare a new file.

2. The Waveform Editor window is depicted in Figure 31. Sdeefile under the namgght.vwf, note that this
changes the name in the displayed window. Set the desiradation to run from O to 200 ns by selecting
Edit > End Time and entering 200 ns in the dialog box that pops up. Selestiagy > Fit in Window
displays the entire simulation range of 0 to 200 ns in the aivncas shown in Figure 32. You may wish to
resize the window to its maximum size.

B! light.vwf (=13
Master Time Bar: 15.95 ns 4| *| Pointer: 47 ns Interval: -11.25 ns Start: End:
Mo Vake at ps 10.0ns 200ns |
15.95 ns 15-9:5 ns

Bl
v

Figure 31. The Waveform Editor window.
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B light.vwi* 9((=E3

Master Time Bar: 15.95 nz 1| ¥| Painter: 968 nz Interval: £.27 nz Start: 0ps End: 200.0 nz
0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
Walue at i i i i
Name 15.95 nz 15.95 ne
|

Figure 32. The augmented Waveform Editor window.

3. Next, we want to include the input and output nodes of theuitito be simulated. ClickEdit > Insert >
Insert Node or Bus to open the window in Figure 33. It is possible to type the nafre signal (pin) into
the Name box, but it is easier to click on the button labéliedie Finder to open the window in Figure
34. The Node Finder utility has a filter used to indicate wigpetof nodes are to be found. Since we are

interested in input and output pins, set the filtePios: all. Click the List button to find the input and
output nodes as indicated on the left side of the figure.

Insert Node or Bus rz|
Mame: | (] 8 |
Type: |INF'UT j Cancel
Value type: |9-LEVE| j Mode Finder...
Fiadix s -]

Bus width: |'I
Start index: |D
[ Display gray code count as binary count

Figure 33. The Insert Node or Bus dialogue.

Node Finder @

Named: |§ v | Filter: | Pins: all v Customize... List ; 0K
k ] Fiter [Pins: o =~ l | Q N

Look in: |[FT L] _I V' Include subentities Cancel
Nodes Found: Selected Nodes:

Name I Assighments ] Type > Name I Assighments I Type

o f PIN_U22 Output 9 [lightl1 PIN_L22 Input

D1 PIN_L22 Input >> || lightx2 PIN_L21 Input

52 PIN_L21 Input £ llightlf PIN_U22 Output

4 < A
< | > << < >

Figure 34. Selecting nodes to insert into the Waveform Edito
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Click on thex1 signal in the Nodes Found box in Figure 34, and then clicktfsign to add it to the Selected
Nodes box on the right side of the figure. Do the samexfandf. Click OK to close the Node Finder
window, and then clickOK in the window of Figure 33. This leaves a fully displayed Wave Editor
window, as shown in Figure 35. If you did not select the noddbé same order as displayed in Figure 35,
it is possible to rearrange them. To move a waveform up or dawime Waveform Editor window, click on
the node name (in the Name column) and release the mousa& biitte waveform is now highlighted to
show the selection. Click again on the waveform and drag dngiown in the Waveform Editor.

B light.vwf =3
Master Time Bar: 15.95 nz 1| ¥| Painter: 10,08 nz Interval: 5.89ns Start: 0ps End: 200.0 nz
0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
N Walue at i i i i
aME | 15,95 ns 15-933 ns
w0 «1 A0
1 %2 A0
£ 2 f A

Figure 35. The nodes needed for simulation.

4. We will now specify the logic values to be used for the infighalsx1 andx2 during simulation. The logic
values at the outpudtwill be generated automatically by the simulator. To maleasy to draw the desired
waveforms, the Waveform Editor displays (by default) \eatiguidelines and provides a drawing feature
that snaps on these lines (which can otherwise be invoketdxysingView > Snap to Grid). Observe also
a solid vertical line, which can be moved by pointing to itg tond dragging it horizontally. This reference
line is used in analyzing the timing of a circuit; move it teettime = 0 position. The waveforms can be

drawn using the Selection Tool, which is activated by setgdhe iconk in the toolbar, or the Waveform
Editing Tool, which is activated by the icCH .

To simulate the behavior of a large circuit, it is necessagpply a sufficient number of input valuations and
observe the expected values of the outputs. In a large titeinumber of possible input valuations may
be huge, so in practice we choose a relatively small (buesgmtative) sample of these input valuations.
However, for our tiny circuit we can simulate all four inpwluations given in Figure 11. We will use four
50-ns time intervals to apply the four test vectors.

We can generate the desired input waveforms as follows.k @iicthe waveform name for thel node.
Once a waveform is selected, the editing commands in the Mfawd=ditor can be used to draw the desired
waveforms. Commands are available for setting a seleagea@lsio 0, 1, unknown (X), high impedance (2),
don't care (DC), inverting its existing value (INV), or deifig a clock waveform. Each command can be
activated by using thEdit > Value command, or via the toolbar for the Waveform Editor. The Bu#nu
can also be opened by right-clicking on a waveform name.

Setx1to 0 in the time interval O to 100 ns, which is probably alreadyby default. Next, setl to 1 in the
time interval 100 to 200 ns. Do this by pressing the mouseeastart of the interval and dragging it to its
end, which highlights the selected interval, and choodiegdagic value 1 in the toolbar. Make = 1 from
50 to 100 ns and also from 150 to 200 ns, which correspond<sttriith table in Figure 11. This should
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produce the image in Figure 36. Observe that the oufpsitdisplayed as having an unknown value at this
time, which is indicated by a hashed pattern; its value vélbletermined during simulation. Save the file.

Master Time Bar: 0ps 1| ¥| Painter: 166.25 ng Interval: 166.25 ng Start: End:

0 pz 200 nz 400 nz B0.0 nz 80.0 nz 100.0 ns 120.0 ns 140.0 nz 160.0 nz 180.0 nz |

. Value at i i i i i i i i i
0ps ? pz

w0 «1 A0 |
1 %2 A0 |
£ 2 f A

< ¥

Figure 36. Setting of test values.

6.1 Performing the Simulation

A designed circuit can be simulated in two ways. The simplest is to assume that logic elements and intercon-
nection wires in the FPGA are perfect, thus causing no delgyapagation of signals through the circuit. This
is calledfunctional simulation A more complex alternative is to take all propagation deliayo account, which
leads tatiming simulation Typically, functional simulation is used to verify the fttional correctness of a circuit
as it is being designed. This takes much less time, becaasgrttulation can be performed simply by using the
logic expressions that define the circuit.

6.1.1 Functional Simulation

To perform the functional simulation, sele&ssignments > Settings to open the Settings window. On the left
side of this window click orSimulator Settings to display the window in Figure 37, chooBenctional as the
simulation mode, and clic®K. The Quartus Il simulator takes the inputs and generatesutpaits defined in the
light.vwffile. Before running the functional simulation it is neceyda create the required netlist, which is done
by selectingProcessing > Generate Functional Simulation Netlist. A simulation run is started blfrocess-

ing > Start Simulation, or by using the icor®. At the end of the simulation, Quartus Il software indicdtes
successful completion and displays a Simulation Repastithted in Figure 38. If your report window does not
show the entire simulation time range, click on the reportdeiv to select it and chood&ew > Fit in Window.
Observe that the outpiftis as specified in the truth table of Figure 11.
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Settings - light

Category:

- Libraries A
Device I

- Dperating Settings and Conditions Select simulation options.

- Woltage

o Temperature =
- Compilation Process Settings :

- Early Timing E stimate Simulation input: |Iight.vwf _J Add Multiple Files...

s Incremental Compilation
- EDA, Tool Settings — Simulation period

- Design Entry/Synthesis ' Rur simulation untl all vector stimul are used
- Simulation

o Timning Analyziz " End simulation at; i r ]
- Formal Verification

- Physical Synthesis Gliteh filtering options:
; g options: | ALt sl
- Board-Level 1 _J

— Analyzis & Synthesiz Settings More Settings...

- WHDL Input
- Werilog HOL Input
- Default Parameters
o Synthesis Metlist Optimizations
- Fitter Settings
s Phyzical Synthesis O ptimization
- Timing Analyziz Settings
- TimeGuest Timing Analyzer
= Claszic Timing &nalyzer Setting
: " Classic Timing Analyzer Re
- Azzembler Drescriptior:
- Diesign Assistant Specifies the type of simulation to perform for the current Simulation focus.
- SignalTap Il Logic Analyzer
Logic Analyzer Interface
- Simulator Settings
PowerFlay Power Analyzer Setting -

22 | > B ok | Cancel

Simulation mode: |{Z8

i

Figure 37. Specifying the simulation mode.

Simulation Waveforms
Simulation mode: Functional

h Master Time Bar: 0ps 1| ¥| Painter: BE4.33 nz Interval: BE4.33 nz Start: End:
A 0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
N Walue at i i i i
o5 ame Ops 0 s
i

@\ w0 «1 A0 |

1 %2 A0 I | J
Iy £ 2 f A0 | |
%,

Figure 38. The result of functional simulation.

6.1.2 Timing Simulation

Having ascertained that the designed circuit is functigradrrect, we should now perform the timing simulation
to see how it will behave when it is actually implemented ia thosen FPGA device. Sele&ssignments >
Settings > Simulator Settings to get to the window in Figure 37, choo$@ning as the simulation mode, and
click OK. Run the simulator, which should produce the waveforms guig 39. Observe that there is a delay of
about 9 ns in producing a change in the sigfidfom the time when the input signals; andx,, change their
values. This delay is due to the propagation delays in thie Elgment and the wires in the FPGA device.

25



Master Time Bar:

Ops

<| »| Pointer: 85.34ns Interval: 85.34 ns Start: End:

PE>s

Name

Value at
Ops

v

|

1
%2
f

AD
A0

ps 400ns 20003
0 ps

i

800ns 120,0ns 160,0ns

J
| N N S N

AD I | S S S I,

|

22

Figure 39. The result of timing simulation.

7 Programming and Configuring the FPGA Device

The FPGA device must be programmed and configured to impletmedesigned circuit. The required configura-
tion file is generated by the Quartus Il Compiler's Assembiedule. Altera’s DE1 board allows the configuration
to be done in two different ways, known as JTAG and AS mode® cldmfiguration data is transferred from the
host computer (which runs the Quartus Il software) to therdbdy means of a cable that connects a USB port
on the host computer to the leftmost USB connector on thedbdar use this connection, it is necessary to have
the USB-Blaster driver installed. If this driver is not ady installed, consult the tutori@etting Started with
Altera’s DE1 Boardfor information about installing the driver. Before usirgetboard, make sure that the USB
cable is properly connected and turn on the power supplycbhwih the board.

In the JTAG mode, the configuration data is loaded directly the FPGA device. The acronym JTAG stands
for Joint Test Action Group. This group defined a simple waytésting digital circuits and loading data into
them, which became an IEEE standard. If the FPGA is configuwrdlsis manner, it will retain its configuration
as long as the power remains turned on. The configuratiomniaftion is lost when the power is turned off. The
second possibility is to use the Active Serial (AS) mode.his tase, a configuration device that includes some
flash memory is used to store the configuration data. Quartaftivare places the configuration data into the
configuration device on the DE1 board. Then, this data isddaato the FPGA upon power-up or reconfiguration.
Thus, the FPGA need not be configured by the Quartus Il softifdine power is turned off and on. The choice
between the two modes is made by the RUN/PROG switch on thebb&M. The RUN position selects the JTAG
mode, while the PROG position selects the AS mode.

7.1 JTAG Programming

The programming and configuration task is performed as@loFlip the RUN/PROG switch into the RUN
position. Selecilools > Programmer to reach the window in Figure 40. Here it is necessary to §péoe
programming hardware and the mode that should be used. Hlresdy chosen by default, select JTAG in the
Mode box. Also, if the USB-Blaster is not chosen by defauless theHardware Setup... button and select the
USB-Blaster in the window that pops up, as shown in Figure 41.

W Quartus Il - D:/introtutorial/light - light - [light.cdf]
File Edit Processing Tools MWindow

&, Hardware Setup... USB-Blaster [USB-0]

™ Enable realtime ISP to allow background programming (for MA&X Il devices)

Mode: [JTAG v | Progress:

Program/ Blank-
Configure Check

........ [m] ] ] ] ] [

File Usercode Erase

P Start |

LEE
ﬂﬂ Auto Detect
[Xodee |
& AddFile...

B prargeien |

For Help, press F1

| Checksum
001BO367

| Device
EP2C20F484

Security
Bit

. . ISP
Werify Examine CLAMP
] ] ]

light. sof

NUM

Figure 40. The Programmer window.
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Observe that the configuration flight.sofis listed in the window in Figure 40. If the file is not alreadistéd,
then click Add File and select it. This is a binary file produced by the Compil&ssembler module, which
contains the data needed to configure the FPGA device. Tleasrh.sofstands for SRAM Object File. Note
also that the device selected is EP2C20F484, which is theAFRSice used on the DE1 board. Click on the
Program/Configure check box, as shown in Figure 42.

Hardware Setup

X

Hardware Seftings I.JTAG Sgttings]

Select a programming hardware getup to use when programming devices. This programming
hardware zetup applies only ta the current programmer window.
Currently selected hardware: USB-Blaster [USE-0]
Available hardware items:
Hardware Server | Fart | Add Hardware...
USE-Elaster Local Use-0

Figure 41. The Hardware Setup window.

W Quartus Il - D:/introtutorial/light - light - [light.cdf*]
File Edit Processing Tools Window

‘.3 Hardware Setup... USEB-Blaster [USE-0] Mode: |JTAG v | Progress: 0%

I” Enable realtime ISP to allow background programming (for M&X Il devices)

w Start File Device Checksum Usercode E::ngfi’gamé Verify g::::k Examine Segli:vity Erase EIE\}PAP
light.sof EP2C20F484 00180367 FFFFFFFF

“‘0 Auto Detect

X Delete

2 Add File...

s Change File...

For Help, press F1 NUM

Figure 42. The updated Programmer window.

Now, pressStart in the window in Figure 42. An LED on the board will light up wiéhe configuration data
has been downloaded successfully. If you see an error expbytQuartus Il software indicating that programming
failed, then check to ensure that the board is properly pesven.

7.2 Active Serial Mode Programming

In this case, the configuration data has to be loaded intodhéguiration device on the DE1 board, which is
identified by the name EPCS4. To specify the required cordigam device selecfAssignments > Device,
which leads to the window in Figure 43. Click on tBbevice and Pin Options button to reach the window in
Figure 44. Now, click on th€onfiguration tab to obtain the window in Figure 45. In the Configurationidev
box (which may be set to Auto) choose EPCS4 and diék Upon returning to the window in Figure 43, click
OK. Recompile the designed circuit.
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Settings - light

Category:
Files
Libraries Select the family and device you want to target for compilation.
Device
[+ Operating Settings and Conditions Device family Show in ‘Available devices' list
[+ Compilation Process Settings o §
[+ EDA Tool Settings e |Cyclone|l LI Package: Any v
[+ &nalysis & Synthesis Settings B Pin count: Any v
Fitter Settings Devices: [al =
[#- Timing Analysis Settings Speed grade: |Any v
Assembler [ Target device [~ Show advanced devices
Design Assistant ¢ Auto device selected by the Fitter I~ HardCopy compatible anly
SIQI’?B'TBD II'Logic Analyzer (¢ Specific device selected in 'Available devices' list
Logic Analyzer Interface B
[+ Simulator Settings € Other: n/a Device and Pin Options... I
PowerPlay Power Analyzer Settings
SSN Analyzer Available devices:
Name | Core v... I LEs I User |4... I Memor... | Embed... | PLL &
EP2C20F256CE 1.2¢ 18752 152 239616 52 4
EP2C20F256C7 1.2¢ 18752 152 239616 B2 4
EP2C20F256C8 1.2¢ 18752 152 239616 52 4
EP2C20F25618 1.2v 18752 152 239616 52 4 &
EP2C20F484C6 1.2 18752 315 239616 52 4
EP2C20F484C7 1.2V 18752 315 239616 B2 4
EP2C20F484C8 1.2¢ 18752 315 239616 52 4 ™
< i | >

 Migration compatibility ——————— ~ Con

Migration Devices... HardCopy =l

0 migration devices selected ¥ Limit DSP & RAM to Hard

oK I Cancel I

% |

Figure 43. The Device Settings window.

Device and Pin Options

Voltage ] Pin Placement I Error Detection CRC
Capacitive Loading I Board Trace Model I 1/0 Timing
General Configuration ] Programming Files I Unused Pins | Dual-Purpose Pins

Specify general device options. These options are not dependent on the configuration
scheme.

Options:

Auto-restart configuration after error
["|Release clears before tri-states

[]Enable user-supplied start-up clock [CLKUSR)
["]Enable device-wide reset ([DEV_CLRn)
["]Enable device-wide output enable (DEY_0E)
[]Enable INIT_DONE output

[~ Auto usercode

JTAG user code (32-bit hexadecimal:  |FFFFFFFF
In-system programming clamp state v

Directs the device to restart the configuration process automatically if a data error is
encountered. If this option is turned off, you must extemally direct the device to

restart the configuration process if an error occurs.
Reset '
oK I Cancel |

Description:

Figure 44. The Options window.
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Device and Pin Options @

Voltage I Pin Placement l Error Detection CRC ]
Capacitive Loading I Board Trace Model ] 140 Timing ]
General  Configuration I Programming Files | Unused Pins | DualPurpose Pins ]

Specify the device configuration scheme and the configuration device. Note: For
HardCopy designs, these settings apply to the FPGA prototype device.

Configuration scheme: IActive Serial [can use Configuration Device) LI
Configuration mode: | _]
Configuration device
v Use configuration device: Auto ;I
Auta
EPCS1
EPCS16
r EPCSE4
EPCS128

[V Generate compressed bitstreams

Description:

Specifies the configuration device that you want to use as the means of configuring
the target device.

Reset
oK | Cancel |

Figure 45. Specifying the configuration device.

The rest of the procedure is similar to the one describedexfismthe JTAG mode. Sele@bols > Program-
mer to reach the window in Figure 40. In the Mode box selsctive Serial Programming. If you are changing
the mode from the previously used JTAG mode, the pop-up bdigare 46 will appear, asking if you want to
clear all devices. Clickles. Now, the Programmer window shown in Figure 47 will appeaak®lsure that the
Hardware Setup indicates the USB-Blaster. If the configomdtle is not already listed in the window, presdd
File. The pop-up box in Figure 48 will appear. Select the fidgat.pof in the directoryintrotutorial and click
Open. As a result, the configuration filkight.pof will be listed in the window. This is a binary file produced
by the Compiler’s Assembler module, which contains the tatse loaded into the EPCS4 configuration device.
The extensionpof stands for Programmer Object File. Upon returning to theggyRmmmer window, click on the
Program/Configure check box, as shown in Figure 49.

'E Some devices in current device list cannot be added to selected programming mode Active Serial Programming. Do you want ko clear all devices in
L

current device list and switch to selected mode?

Figure 46. Clear the previously selected devices.
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éa Hardware Setup...| | U5B-Blaster [USE-0]

™ Enable realtime ISP ta allow background prograrring (for MAK || devices)

Mode: | Active Serial Programming + | Progress:

Frogram/
Configure

File Device ‘Ehecksum Uszercode Werify ‘ Elﬁggk

‘ Examine

Security
Bit

‘ Eraze
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(2 4dd File...

5 crergerie |
Bbsaverie. |
# 4dd Device. .
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|

Figure 47. The Programmer window with Active Serial Progminyg selected.

L3

Select Programming File

Look in: JDmtrotulonal :_] = ﬁ Ea-

My Recent
Documents

My Documents

My Computer

&&

My Metwork File narne: |I|ghl Open

Places “_J
Files of type: |PDF Filess [*.pof] _'_] Cancel

Figure 48. Choose the configuration file.

Quartus Il - D:/introtutorial/light - light - [light.cdf*]

File Edit Processing Tools Window

éa Hardware Setup... USE-Blaster [USE-0] Mode: | Active Serial Programming v | Progress:

™ Enable realtime ISP to allow background programming (for M&X, || devices)

o
2

Program/

Configure Verify Examine

Checksum Usercode

light. pof 05F1ED3C 00000000

X Delete
el
s Change File...

For Help, press F1

Security
Bit

NUM

Figure 49. The updated Programmer window.
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Flip the RUN/PROG switch on the DE1 board to the PROG positiBressStart in the window in Figure
49. An LED on the board will light up when the configurationaldas been downloaded successfully. Also, the
Progress box in Figure 49 will indicate when the configuraiad programming process is completed, as shown
in Figure 50.

W Quartus Il - D:/introtutorial/light - light - [light.cdf*]
File Edit Processing Tools Window

r.?a Hardware Setup... USB-Blaster [USB-0] Mode: | Active Serial Programming v | Progress:

I Enable real-time ISP to allow background programming (for M&X 1| devices)

P Start File Device Checksum Usercode E’o‘;g?g;mé Verify gl:en é(k Examine Segl;vity Erase Cle':llP
light. pof 05F1ED3C 00000000

X Delete

s Change File...

For Help, press F1 NUM

Figure 50. The Programmer window upon completion of prognamy.

8 Testing the Designed Circuit

Having downloaded the configuration data into the FPGA dgwou can now test the implemented circuit. Flip
the RUN/PROG switch to RUN position. Try all four valuatioofsthe input variables:; andz,, by setting the
corresponding states of the switchgl’; and. SW,. Verify that the circuit implements the truth table in Figur
11.

If you want to make changes in the designed circuit, firsteltee Programmer window. Then make the
desired changes in the Block Diagram/Schematic file, cartpié circuit, and program the board as explained
above.
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